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File Type: TEXT (XYZ Point File)

Directions: XYZ<->MF

Details: This translator will import and export text files composed of a list of poin
Each point is expected to have an X and Y coordinate, a Z value sepa
by tab characters, and be terminated with a carriage return (i.e., 
X<tab>Y<tab>Z<return>). The X and Y coordinates may be row/colum
latitude/longitude, UTM, or a user defined X/Y system. The Z value may
either fixed point/integer or floating point/real. To be recognized by the
translator, XYZ files must have the “.xyz” extension.

XYZ files are produced commonly by GPS (Global Positioning System
units and other field data collection methods. The data are typically sp
points referenced to a real-world coordinate system like Latitude/Longit
or UTM. A user defined grid can also be used to reference data points w
a mapped area. This is particularly useful when surveying points acros
UTM boundaries.

GPS units gather X/Y positional coordinates for points and any numbe
attributes attached to those points. One XYZ file should be generated 
each attribute that you want to map. Descriptive text can be appended
your imported XYZ data by using the Tab Delimited Text translator to 
import legend text.

When you are exporting to an XYZ file you can retain the legend text b
using the Tab Delimited Text translator to export legend text.

Importing an XYZ Tab Delimited Point File
Exporting to an XYZ Tab Delimited Row/Column Point Fil
Exporting to an XYZ Tab Delimited UTM Point File
Exporting to an XYZ Tab Delimited X/Y Point File
TR-XYZ-1© Copyright ThinkSpace Inc., 1998, Version 1
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Importing an XYZ Tab Delimited Point File

Import Dialog Using the translator dialog box interface
Using the dialog box interface to create or edit scripts

Coordinate Range/Scan For Range
Use the North , South, East, and West fields to specify the extents of the 
map data. These values must reflect the coordinate system of the inpu
To have these fields populated automatically, click on the Scan For Range 
button. This will determine the outermost extents of the input file and pl
the values in the appropriate fields.

These values can be modified to extract only a portion of the file or to 
specify a map layer that exceeds the extents of the input data. To do so,
in the appropriate field and enter the new value. These values may be
X-Y coordinates, UTM coordinates, or latitude/ longitude coordinates 
depending on the referencing system in the coverage file.

Grid Size
The Grid size field is used to specify the grid interval of the resulting ma
layer. This value will become the cell resolution of the new map layer. The 
value for this option must be expressed in the coordinate system of the
input file .

If the coordinate system of the input map layer is latitude and longitude, 
then the value specified for the Grid size option should be the number of 
degrees per cell side (specify None for units). Future releases of this 
translator will allow you to specify a cell resolution in metres. For users w
TR-XYZ-2© Copyright ThinkSpace Inc., 1998, Version 1
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a background in programming, ThinkSpace Inc. has a C routine availab
convert latitude and longitude grid sizes to metres; after you have impo
a map layer with a latitude and longitude coordinate system, you can 
convert your degrees per cell side cell resolution to metres per cell sid

If the coordinate system of the input map layer is UTM (Universal 
Transverse Mercator), then the value specified for the Grid size option 
should be the number of UTM metres per cell side.

The smaller (i.e., finer) the grid size, the higher the cell resolution (i.e., the 
greater the number of cells).

Collision
If a coordinate point occurs more than once in the input file, a conflict 
results. Click on the Replace radio button to have the last occurrence of th
point in the file replace any previous occurrences. Click on the Add radio 
button to have the Z value of coincidental points added together in the
output map layer.

Origin
Use this option to identify the location of the origin of the input file 
coordinate system. X/Y and longitude/latitude have an origin in the low
left hand corner of the map. MFworks uses a row/column coordinate sys
with the origin in the upper left hand corner of the map layer.

Import Syntax Syntax and type conventions
Using the Script window interface
Using the dialog box interface to create or edit scripts

Import input file  Using “Text (Point File)”
North value  South value  West value  East value
GridSize value
[ReplacePoints | AddPoints]
[LowerLeftOrigin | UpperLeftOrigin];

North value
South value
West value
East value
These options specify the extent of the area in the point file to be raster
These values must reflect the coordinate system of the input file. The va
may be modified to extract only a portion of the file or to specify a map la
that exceeds the extents of the input data. Enter appropriate values 
following each modifier. These values may be true X-Y coordinates, UT
TR-XYZ-3© Copyright ThinkSpace Inc., 1998, Version 1
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coordinates, or latitude/longitude coordinates depending on the referen
system in the coverage file.

GridSize value
The GridSize  modifier is used to specify the grid interval of the resultin
map layer. This value will become the cell resolution of the new map la
The value for this option must be expressed in the coordinate system o
the input file.

If the coordinate system of the input map layer is latitude and longitude, 
then the value specified for the GridSize  option should be the number of
degrees per cell side (do not specify units). Future releases of this transl
will allow you to specify a cell resolution in metres. For users with a 
background in programming, ThinkSpace Inc. has a C routine availabl
convert latitude and longitude grid sizes to metres; after you have impo
a map layer with a latitude and longitude coordinate system, you can 
convert your degrees per cell side cell resolution to metres per cell sid

If the coordinate system of the input map layer is UTM (Universal 
Transverse Mercator), then the value specified for the Grid size option 
should be the number of UTM metres per cell side.

The smaller (i.e., finer) the grid size, the higher the cell resolution (i.e., the 
greater the number of cells).

ReplacePoints
AddPoints
If a coordinate point occurs more than once in the input file, a conflict 
results. Choose ReplacePoints to have the last occurrence of the point in th
file replace any previous occurrences. Specify AddPoints to have the Z 
value of coincidental points added to any previous occurrences point in
output map layer.

LowerLeftOrigin
UpperLeftOrigin
Use these modifiers to identify the origin of the input file coordinate syste
X/Y and longitude/latitude have an origin in the lower left hand corner 
the map. MFworks uses a row/column coordinate system with the orig
being in the upper left hand corner of the map layer. In a script statement, if 
this modifier is not specified for the input file, the origin is assumed to 
the upper left hand corner, by default.
TR-XYZ-4© Copyright ThinkSpace Inc., 1998, Version 1
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Example

Importing an XYZ Tab Delimited Point File
A set of coordinate points and attribute values were collected using a G
(Global Positioning System) unit. The data are exported to a spreadsh
program where separate XYZ files are generated for each attribute:
TR-XYZ-5© Copyright ThinkSpace Inc., 1998, Version 1
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The spreadsheet files are then exported as tab delimited ASCII text file
Each line represents a point in space and an associated value:

To convert this point data to an MFworks map layer select Import Map  
from the File menu. Select the file and choose XYZ Point File (Text) from 
the Show Type drop-down list. When the Import XYZ Point File (Text)  
dialog box appears the Row/Column origin radio button is clicked, then the
TR-XYZ-6© Copyright ThinkSpace Inc., 1998, Version 1
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Scan For Range button is clicked. This causes the Coordinate Range 
fields to be populated automatically. The default Replace option is used:

If you were to execute this operation from the Script window the statement 
would be:

GPSPoints = Import “GPSPoints.txt”
Using “Text (Point File)”
North 0 South 99 West 0 East 99
GridSize .2475 ReplacePoints
UpperLeftOrigin;

When the map is displayed on screen, the default colour sequence wil
applied to the map zones. Z values from the input file will be assigned
zone values:
TR-XYZ-7© Copyright ThinkSpace Inc., 1998, Version 1
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When an XYZ Point file is imported, the geometry for the resulting map is 
generated automatically by the translator according to the coordinates o
original file.

Exporting to an XYZ Point File

Export Dialog Using the translator dialog box interface
Using the dialog box interface to create or edit scripts

The Coordinate system drop-down list options are based on existing 
geometries. Each built geometry will appear in this menu automatically. If
no geometry exists for the map layer, then Row/Column with the origin in 
the top left hand corner appears by default.

Export Syntax Syntax and type conventions
Using the Script window interface
Using the dialog box interface to create or edit scripts

ExportMap map To output file
Using “Text (Point File)”
[Reference map [ with geometry ] ];

Note: You must enclose the name of the referenced geometry with squ
brackets.
TR-XYZ-8© Copyright ThinkSpace Inc., 1998, Version 1
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Reference with geometry
Use this modifier to specify the name of a geometry that has been built for 
the map layer to be exported. You can also specify a geometry from a
alternate map layer.  If no geometries have been built or this modifier h
not been specified, then the Row/Column geometry with an origin in the
left hand corner of the map is assumed.

Export
Example

Exporting to an XYZ Tab Delimited Row/Column Point File
A Geological Survey was conducted through this study area in the sum
of 1998. Outcrops belonging to four formations were found in the area 
a map layer was generated from GPS (Global Positioning System) read
This mapped data is to be exported and used in a vector based Geolo
Modelling application:

The map data is to be exported in Row/Column format. Export Map  is 
selected from the File menu. The name of the file and a file type of XYZ  is 
specified in the Save file dialog box. When the Export XYZ Point File 
TR-XYZ-9© Copyright ThinkSpace Inc., 1998, Version 1
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(Text) dialog box is displayed Row/Column is selected from the 
Coordinate system drop-down list:

If you were to perform this command from the Script window the statement 
would be:

ExportMap “Summer 1998 Survey”
To “Summer 1998 Survey (RCZ)”
Using “Text (Point File)”;

Before using the file in the Geological Modelling application the data a
examined in a word processing application. XYZ files are tab delimited
TR-XYZ-10© Copyright ThinkSpace Inc., 1998, Version 1
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ASCII text files that can be opened by most word processing and 
spreadsheet applications:

Export
Example

Exporting to an XYZ Tab Delimited UTM Point File
A Geological Survey was conducted through this study area in the sum
of 1998. Outcrops belonging to four formations were found in the area 
a map layer was generated from GPS (Global Positioning System) read
TR-XYZ-11© Copyright ThinkSpace Inc., 1998, Version 1
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This mapped data is to be exported and used in a vector based Geolo
Modelling application:

The map data is to be exported in UTM Northing/Easting format. Export 
Map is selected from the File menu. The name of the file and a file type o
XYZ  is specified in the Save file dialog box. When the Export XYZ Point 
File (Text) dialog box is displayed UTM  is selected from the Coordinate 
system drop-down list:

If you were to perform this command from the Script window the statement 
would be:
TR-XYZ-12© Copyright ThinkSpace Inc., 1998, Version 1
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ExportMap “Summer 1998 Survey”
To “Summer 1998 Survey (UTM)”
Using “Text (Point File)”
Reference “Summer 1998 Survey” [UTM];

Before using the file in the Geological Modelling application the data a
examined in a word processing application. XYZ files are tab delimited
ASCII text files that can be opened by most word processing and 
spreadsheet applications:

Export
Example

Exporting to an XYZ Tab Delimited X/Y Point File
A Geological Survey was conducted through this study area in the sum
of 1998. Outcrops belonging to four formations were found in the area 
a map layer was generated from GPS (Global Positioning System) read
This mapped data is to be exported and used in a vector based Geolo
Modelling application.

Before the file can be exported in an XYZ format, a new X/Y geometry 
must be built for the file to move the position of the origin from the top l
hand corner to the bottom left hand corner. This simple process is outl
TR-XYZ-13© Copyright ThinkSpace Inc., 1998, Version 1
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in the figure below. First determine the Row/Column extents of the ma
layer, then mirror the positions vertically. Open the Geometry Editor 
dialog box by selecting Edit Geometry from the Map menu, and enter the
Row/Column coordinates and their corresponding X/Y coordinates, spe
a new name and click on the Build  button. UTM Metres was selected from
the Format drop-down list to give the correct numerical format to the 
output X/Y coordinates:

(0,0) (0,190)

(290,0) (190,290)

Row/Column
(0,290) (190,290)

(0,0) (190,0)

X/Y
TR-XYZ-14© Copyright ThinkSpace Inc., 1998, Version 1



 

 

The new geometry can be checked by returning to the Map window and 
specifying the new geometry from the Ruler Coordinates sub menu of the 
Map menu:

Export Map  is selected from the File menu. The name of the file and a file
type of XYZ  is specified in the Save file dialog box. When the Export XYZ 
Point File (Text) dialog box is displayed, the new geometry is selected
from the Coordinate system drop-down list:

If you were to perform this command from the Script window the statement 
would be:
TR-XYZ-15© Copyright ThinkSpace Inc., 1998, Version 1
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ExportMap “Summer 1998 Survey”
To “Summer 1998 Survey (XYZ)”
Using “Text (Point File)”
Reference “Summer 1998 Survey” [“RC to XY”];

Before using the file in the Geological Modelling application the data a
examined in a word processing application. XYZ files are tab delimited
ASCII text files that can be opened by most word processing and 
spreadsheet applications:
TR-XYZ-16© Copyright ThinkSpace Inc., 1998, Version 1
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